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Introduction

This manual is designed to help users of Signature Series product line, also known as broadband
instruments, to get familiar with the system and how to use it. The manual includes chapters
covering how to get the instrument up and running as quickly as possible, functional testing, software
information, and tips for maintenance and troubleshooting. Take a look at Principles of Operation -
Signature for more in depth understanding on how the instrument works. For information about how to
communicate, control and develop for your instrument, consult our Integrators Guide - Signature.

Nortek online

At our website, www.nortekgroup.com, you will find technical support, user manuals, and the latest
software and firmware. General information, technical notes, and user experience can also be found
here.

Nortek FAQ

Our old forum where users from all over the world met to discuss and shared their experience with
Nortek instruments has been conwerted to an FAQ section. If you have comments, questions,
application tips, suggestions for improvements, or simply want to learn from others or share your own
experience, we encourage you to comment on the relevant FAQ or start a topic in our new forum.

Your feedback is appreciated
If you find errors, omissions or sections poorly explained, please do not hesitate to contact us. We
appreciate your comments and your fellow users will as well.

Contact Information

We recommend first contacting your local sales representative before the Nortek main office. If you
need more information, support or other assistance, you are always welcome to contact us or any of
our subsidiaries by email, phone or fax.

Email: inquiry@nortekgroup.com for general inquiries or support@nortekgroup.com for technical
support

Phone: +47 67 17 45 00

Fax: +47 67 1367 70

You can also write us at:

Nortek AS
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1351 RUD

Norway

Version/revision Date Comments
2014.1 28.10.2014 Release

2014.2 17.11.2014

2014.3 02.12.2014

2015.1 09.06.2015 Software updates
2015.2 24.11.2015 Instrument updates
2016.1 29.02.2016 Software updates
2016.2 15.09.2016 Software updates
2017.1 10.02.2017
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2017.2 08.12.2017

2018.1 26.06.2018

2018.2 21.09.2018

2021.1 04.06.2021 General updates, new software
examples

2022.1 09.02.2022 General updates, formatting

2022.2 29.09.2022 Minor updates

ce

The system is designed and produced to comply with the council directive of 2014/108/EC relating to
electromagnetic compatibility. The instrument has passed the following tests according to EN61000-6-
2:2005 and EN61000-6-3:2007/A1:2011/AC:2012 (practically similar to US FCC 15 part A in US):
Conducted and radiated emission, voltage flicker, harmonic current, conducted radio frequency
immunity, radiated electromagnetic field immunity, fast low energy transients/bursts, slow high energy
transients/surges, voltage dips and interruptions, electrostatic discharge and power-frequency magnetic
field. The design is also according to RoHS Il directive 2011/65/EU.

The mark on the left is in compliance with the Waste Electronic Equipment Directive 2012/19/EU
(WEEE). This symbol indicates the requirement NOT to dispose the equipment as unsorted municipal
waste, but use the return to collection systems according to local law or return to the Nortek facilities
(address above).

A

POM

Relevant plastic parts on the product is marked for end of life recycling (Directive 2008/98/EC on waste)

Nortek AS
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System Overview 55/100

The Signature55 and Signature100 operate as long range profilers of 1000m and 400m, respectively.
The Signature55 uses dual frequency, 55kHz and 75kHz, with true broadband technology for both
long, coarse resolution profiles and shorter, fine resolution profiles. The Signature100 has an optional
central echosounder with three frequencies (70, 90 and 120kHz), each available with pulse
compression to detect biological activity in the water column.

The figures below show the Signature55 but can be easily translated to the Signature100. The sensor
head has three/four acoustic transducers slanted at 20 degrees from wertical, plus optional echo
sounder for the Signature100. For dimensions, please refer to the specific instrument data sheet,
available for download from our website. The pressure sensor, temperature sensor and LED light are
all visible from the outside. Note also the beam configuration, with beam one pointing in the positive
X-axis (see the engraved axis definition on the head).

Positive
X-direction

Transducer
(beam number)

Temperature
sensor Pressure

sensor

Head ID

Figure 1. Signature55 beam and sensor overview
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Grounding point

Connectors

End cap

Pressure release release bolts

Battery pack
(inside)

Mounting holes Housing

Figure 2. Signature55 housing, end cap and connectors overview

Connector

Online: 7-pin Souriau

Stand alone: 2-pin + 6-pin brass Subconn by MacArtney

Optional: 8-pin + 6-pin brass Subconn by MacArtney if ordered with serial communication

Battery:
Online: No integrated battery
Stand alone: Double alkaline 1080Wh 18V, or double lithium 3600Wh 19V.

Power requirements:
Online: 15-48V
Stand alone: 15-48V

External power supply:

DC input. 15-48V. We recommend using the supplied DC adapter (24V).

Note: Signature instruments cannot use Power over Ethernet (PoE) technology. Using PoE with your
Signature instrument will damage the electronics board and require repair.

Nortek AS
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3.2

3.3

Getting Started

This chapter deals with installation of the accompanying software, connecting to the instrument and
other information that is important for first time use of the instrument.

Checking the Inventory

Check the contents of the received package against the packing list included in the shipment. Do not
hesitate to contact us if you find any part of the delivery missing.

Installing Software

The Nortek Deployment software is an important part of the Signature series and has been designed
to aid you in the planning, execution and recowvery of your instrument deployment. A thorough
description of the software and its features can be found in the Operations manual. We recommend
that you update when prompted by the software to ensure that you have all the new functionality
accessible. To install the software:

¢ Microsoft Store version: Follow the link on our software page; this will open MS Store from where
you can install SignatureDeployment.

¢ Installer version: Find this version on the memory stick that came with the instrument, or
download it from our software page. This version includes dependencies that may need to be
installed prior to installing the .msix file. If you have difficulty installing this version even with the

dependencies, contact Nortek Support.

System requirements:

Component Requirement

Processor 1 GHz or faster processor

Memory 1 GB RAM

Hard disk 100 MB (programs)

Operating system The software will run on Windows Vista or newer with .NET

framework 4.5. If you use Mac OS platform: you hawe to rely on
Windows-on-Mac virtualization programs such as Parallels
Desktop

Display 1024x576 or higher resolution monitor

Licenses:

The Deployment software itself does not require a license to run. However, certain functions of the
Signature instrument are protected under different licenses, so register your licenses (refer to the
software help file for how to do this) in order to get the instrument to operate in a certain mode.
Register purchased licenses while connected to your instrument under Instrument > Licenses.
Licenses that are ordered with the instrument are already registered. You will not need a license
when updating the firmware version.

Connecting the Instrument to PC via Ethernet

The Ethernet communication has been implemented by using a dedicated network processor, and
needs to be powered by connecting a power supply to the external power breakout on the cable.
Note that powering through the Ethernet cable will also power the rest of the electronics.

Nortek AS
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3.4

DO NOT APPLY POWER TO THE ETHERNET CABLE BEFORE YOU HAVE CONNECTED THE
CABLE TO THE INSTRUMENT

If you power the Ethernet cable before you connect it to the instrument, there is a risk that
you will connect the cable incorrectly and apply power to the wrong lines. This will cause
components on the board to burn out. If this occurs, you will see a loss of communication

and you will need to return the instrument to Nortek for repair.

1. Connect the supplied test cable to the communication output on your instrument, then apply
power to the breakout cable. The blue LED should be turned on shortly.

2. Use a direct connection or an Ethernet switch to connect the Ethernet connector to your
computer.

3. If you use a computer Ethernet port that has status lights, verify that the link is active by looking
for a solid green light on the port. If an Ethernet switch is used, the Ethernet port should also
show an active Ethernet link. If the status light is not lit refer to our Troubleshooting Guide.

External power

Ethernet
Ethernet cable

processor system

vy

Power/serial or
external battery
cable

Figure 3. Power distribution. When the Ethernet cable is connected to the instrument, it will need to be
powered from the power breakout cable. This will power both processor systems. If power is supplied
through the Serial or external battery connector, the Ethernet processor is unavailable.

Initial Ethernet Connection

The first time using the instrument, the network address needs to be properly configured for the
network. For new users who are unaware of how the network is set up, the instrument should be
plugged either directly into a computer (Ethernet cable) or via an Ethernet switch connected to the
computer. For more information consult the Appendix.

Remember that external power must be supplied to connect using the Ethernet interface. Ensure that
the correct cable is used to connect the instrument to the Ethernet port. Refer to the previous section
or the Troubleshooting Guide if the LED on the instrument, the PC port or the switch are not lit in the
correct manner.

1. Check the internet access status at the notification area in the taskbar of your PC. The
screenshot below shows that a local connection has been established (the IP address has been
set).

Nortek AS
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Currently connected to:

nortek.local
1 Internet access

Open Metwork and Sharing Center

Figure 4. Local connection dialog box.

2. Open the Nortek Deployment software and click Connect to launch the Discovery feature (figure
5). This will produce a window with a list of instruments available on the network. It may take a
few minutes before the Discovery tool lists a newly connected instrument. This is due to the IP
address assignment process (more details are available in Appendix). If the instrument is not
shown in the list, wait approximately 90 seconds and click Discover again. The computer is
capable of communicating with the instruments shown with a white background in the list. If an
instrument in the list has a red background, it is not possible to connect to it (see section
Software Problem).

3. Select the instrument by finding the Serial number that matches your instrument and click
Connect. With multiple instruments, assigning a suitable nickname for identification purposes
should be useful. This can be found under Instrument > Nickname once you are connected.

Connect to instrument

Nickname Instrument Serial number Frequency Firmware Connection

Nortek-bench Signature 1000 1001 1000 7022 4 169.254.2449

Discover

IP address : [ | Serial port Baud rate

Figure 5. Discovery dialog

Nortek AS
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3.5
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Serial communications

The Signatures can be purchased with both Ethernet and Serial communications. When connecting
with serial, the only way to communicate with the Signature is through a terminal. The terminal in the
SignatureDeployment software can be used, but no other part of the GUI will be available when
connected over serial. Therefore any streamed data will only be available at binary or ASCII text.

For information on how to control the Signature instruments over a serial connection, please read the
Signature Integrators Guide.

Preparation

From this point on it is assumed that a stable, reliable connection with the instrument has been
established. This is necessary to continue onwards for the next few sections of the manual. If the
instrument is unable to connect with your PC please revisit the Getting Started chapter or consult the

Troubleshooting chapter.

ALWAYS ENSURE YOUR SIGNATURE HAS THE LATEST FIRMWARE

Nortek releases firmware updates multiple times per year. We are constantly improving
Signature functionality and components, so it is extremely important that the firmware on
your instrument is kept up-to-date. Failing to keep the firmware updated may mean that
your instrument will not work as intended.

Updating the firmware will not affect your installed licenses.
When you connect to a Signature, the SignatureDeployment software will prompt you to

update the firmware if a new version is available (when connected to the internet). You can
also check the Software page for updates. See this chapter for instructions.

Functionality Test

Before every deployment it is strongly recommended to undergo a functionality test to ensure that
the various components are working as intended. Before continuing make sure that your instrument
is connected as described in Initial Ethernet Connection. The Functionality Test procedure also
assumes that you are familiar with the Deployment Software as described in the Deployment Wizard
section.

First we need to create a .deploy file which preferably samples at the maximum rate. To do so use
all the default options except Average interval and Measurement interval which should be set to the
lowest common value.

Once connected, select Online > Start Data Collection, and select the .deploy file we just created
which will start real time sampling. An easy way to tell if the instrument is sampling is to check the
LED which will blink every time a ping is sent by the instrument.

Once the instrument is sampling you will find information regarding the various sensors in the main
screen, refer to Online Data Collection for more information.

First check that your firmware version is up to date with the Nortek software page. When you
purchase a brand new instrument, it has a firmware version matching the PC software, hence no

Nortek AS
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firmware upgrade will be needed before you start using the instrument. Howewver, new functionality
(and bug fixes) is likely to be offered in the future, requiring that the firmware be updated. New
firmware is posted on the Nortek software page. Download the version corresponding to your
instrument type. Click Instrument > Firmware Upgrade and follow the on-screen instructions. You
must reformat and reboot the instrument after every firmware upgrade.

Note: If you leave the instrument collecting data using the internal batteries it will run until depletion.
Always make sure to stop data collection when testing is complete.

Temperature
To test the temperature sensor simply read off the corresponding value and compare with your room
temperature.

Pressure

The pressure sensor outputs the absolute pressure value in units of dBar. During production, the
sensor is adjusted to 9.5 dBar to output the gauge pressure (pressure relative to the atmospheric
pressure). The pressure sensor cannot output negative values. The outcome is that when the
instrument is in air, you will see a value of 0.2-0.7 dBar, depending on atmospheric conditions.

Test the pressure sensor by submerging the instrument in approximately 0.5 m of water. The value
should read 0.5 dBar + the ambient pressure of 0.2-0.7.

An alternative way to test whether the sensor is functioning is by forming a seal around the sensor
with your mouth and blowing to observe an increase in pressure.

Tilt

1. Find the X mark located on the instrument and identify which direction it is pointing.

2. Hold the instrument as level as possible while aiming the X direction away from you. The values
for "Pitch" and "Roll" should now be close to zero.

Tilt the instrument 10° to the right. The "Roll" value should read approximately 10.

Tilt the instrument 10° to the left. The "Roll" value should read approximately -10.

Tilt the instrument 10° forwards. The "Pitch" value should read approximately -10.

Tilt the instrument 10° backwards. The "Pitch" value should read approximately 10.

Now turn the instrument upside-down, still aiming the X direction away from you. Repeat steps 2 -
6 and ensure you have the same values. Note that an AHRS-enabled instrument will read 180°
when upside-down.

NOo oA

Note: While holding the instrument upside-down the Accelerometer Z value should read -1.

Nortek AS
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Figure 6. Definitions of beam number, pitch and roll

Compass
Point the X direction towards North. Rotate the instrument around the Z-axis and check the values at
0, 90, 180, 270 degrees corresponding to North, East, South and West respectively.

Electromagnetic interference from magnets, metals, etc in the vicinity can interfere with the
measurement so take this into consideration when evaluating the result. Check the Compass

Calibration section for more information.

Amplitude

Each beam measures amplitude in dB and should be checked individually. Do this by shooting one
beam at a time into water (or a water filled bag), you should see a peak in amplitude corresponding
to the individual beam number you are testing. You will also see an effect in the amplitude by rubbing
or tapping the transducer (see image below). The beams are numbered 1-4 starting with the beam
facing the X-direction and going clockwise.

Figure 7. Example of an amplitude test.
Rub or tap the transducer with your
hand

Nortek AS
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Check and record the noise floor (amplitude) for the instrument in air. Values should be between 20
and 30 dB, this will vary with bandwidth and frequency used. Submerge the sensor head and check
the maximum amplitude, values should increase significantly. Since the instrument relies on
scattering particles, clean water will give low returned signal strength. The purpose of the test is to
see that the returned signal has a significant increase in strength relative to the noise floor. All the
beams should have approximately the same values.

Note: Background noise is very prone to interference from nearby sources, such as a power supply.
During testing make sure the instrument is far enough away from other electronics.

Correlation
Correlation values should show a significant increase when the transducers are submerged in water
compared to the values in air.

Recorder/Memory

1. Test the recorder by selecting Deployment > Start Recorder Deployment.

2. Name the file "test" and start deployment. A notification may appear warning the instrument is
running off an external power supply, press Yes to continue.

3. A popup confirming your deployment will appear, press OK. You will be taken back to the Home
screen while the instrument is deployed.

4. After a few minutes, stop the data collection by reconnecting to your instrument.

5. Find the "test.ad2cp" file you created under Deployment > Recorder Data Retrieval and press

the u icon.

6. Select Deployment > Data Conversion and find your downloaded "test.ad2cp" file using the
Add file feature. Specify the folder you want to save the converted Matlab file in and press Start.

Note: We recommend starting new deployments with an empty memory. Before you erase the
recorder, make sure that you have transferred all the data you want to retain. Click Deployment >
Recorder Data Retrieval and Erase Recorder.

Changing Batteries

The internal battery pack is located inside the housing. Note that the instruments are shipped with
the battery disconnected.

You can estimate the power consumption before the deployment using the planning module in the
Deployment Software. We encourage using new batteries for each deployment.

To connect the battery pack for the first time or to replace it with a new one, follow the guidelines
below.

Place the instrument with the end-cap facing up and remowe the six
bolts. Take a second to note how the end cap is oriented with the
housing. The positive X-axis points away from where the cables are
pointing.

Nortek AS
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If the lid is stuck, use the supplied tools (see picture) and place

them in a notch on each side of the canister. Twist in opposite|:

directions to loosen the lid then slowly lift up the end cap.

Disconnect the 2-pin and 9-pin cables from the end cap. It may be
necessary to have another person holding the end cap while
disconnecting.

Grab the battery by the harness located on top. Orient the battery
so the emerging cables will face the communication and power
cables inside the instrument. While holding the cables neatly along
the wall of the canister, lower the first battery ertically into place.
Be careful to not twist or damage the padding attached to the
battery.

Lower the second battery into its place on top of the first battery.
Connect the bottom battery to the one on top so they are in parallel.

Thread the harness through the styrofoam ring as shown in the
picture.

Connect the top battery to the power break out from the serial
communications cable coming from inside the instrument.

Check the O-rings on the end cap are maintained as per described
in the O-ring Care section. This is perhaps the most crucial step
because it ensures the instrument does not leak in water.

Connect the 2-pin and 9-pin wires together. It may be necessary to
have another person holding the end cap while reconnecting the
cables.

Make sure the end cap is oriented correctly as you put it back in
place. Take special note that none of the wires are squeezed when
placing the end cap.

Nortek AS
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Press down the end cap with hand force while fitting one of the bolts
into place.

Loosely cross tighten each screw before tightening properly. Refer|
to the Securing Screws section for more detailed information.

Note: You will need to do a new compass calibration after changing your battery as the magnetic
interference will be different from before.

Note: Make sure to always include a desiccant bag in the housing and canister. Humid air can
condense enough water to cause damage.

Check and follow local regulations about proper disposal of batteries (alkaline or lithium) as this
varies between countries.

Nortek AS
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Guide rail harness removal

This section is relevant for Signatures with long housings that will be powered by Lithium batteries.
With the Lithium batteries there is not enough room in the housing with the standard guide rail
installed, so the solution is to remowe it. The following describes the procedure.

Figure 8: 1: Housing, 2: Set
screws, 3: Rail, 4: Bracket,
5: Screws

Open the battery compartment as described in the previous section
Remove the two screws (5) that fix the bracket (4) to the housing (1). (Thelh'R
numbering refers to the figure above)

Removwe the bracket, and carefully slide the guide rail harness (3) out. It is
fixed to the base plate with set screws (2) so it should not be difficult to pull it/
out.

The rail is secured with an extra set of screws and washers

Connect the battery. Follow the guidelines in the previous section for details

If the harness should still be secured to the side, the rail can be replaced by a piece of duct tape to
make the installation of a new battery a bit easier.

Nortek AS
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4.4

Compass Calibration

The steps below applies both to instruments with a standard magnetometer and to those with the
AHRS option.

1. Assemble the frame/buoy with the instrument, battery canister, extra ballast, etc. so as to
simulate the intended deployment setup as closely as possible.

2. Connect the system to the computer. Click Instrument > Compass Calibration.

3. Be prepared to rotate the entire system slowly around the Z axis of the instrument. Click Start.
Note that when doing this in the field, you cannot expect to produce a perfect circle. Howewver, we
recommend you to do this slowly, approximately 30 seconds per 360°, in an attempt to come as
close to the ideal circle as possible.

4. After full rotation click Stop. If the data collected is suitable for calibration, the Quality indicator
turns green. Yellow indicates an adequate calibration and red indicates a bad calibration. A good
calibration will have a relatively flat Corrected Normals graph.

5. To use the obtained values, click Update. You will be prompted to confirm that the offset values
shall be transferred to the instrument to serve as the new compass setting.

Compass Calibration = a

Horizontal field

Mxyz Hard Iron Calibration
mmm== Ellipse Fit

400 - Start | Record data

200 - ® 2D e Calibrate
) Verify

0 1. Press Start
2. Rotate slowly at least 360 degrees
around the Z-axis
3. Press Stop
4. Press Update to save offsets

Y (counts)

| |
0 500 Load data file

X (counts) | Undate Quality .
Normals

=0 Normals EEEEE Corrected Nomals Est maguitiide error (% 592

X offset -107
Y offset 21
1.0-
Mx -118
My -94
| | | I | | | Mz -578
100 125 150 175 200 225 250 275 Heading (deg) 201.65
s (x) pitch (deg) -10.44
Roll (deg) 0.62

05-

Hormeal Value

Figure 9. 2D Compass calibration dialog box

Typically you will see offsets coming from these two sources:
Hard Iron (X/Y offset): This will cause a shift in the position of the ellipse away from the origin (0,0).
Soft Iron (Mx, My, Mz): This will deform the ellipse.

After the instrument offsets have been updated the calibration can be verified be re-executing the data
collection and rotation and ensuring that the circle produced is centered on (0, 0, 0) (and that the
corresponding offset corrections are close to 0). This will verify that the hard and soft iron influences
have been compensated for.

Ticking "Record data" will write the compass calibration values to a .txt file in the C:\...
\Documents\Nortek\Deployment\Online folder, e.g. CompCalib_20210604T094001.txt). You can then
use this file to apply the same calibration to the same or another instrument using "Load data file".

Nortek AS
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4.5

Note: Be aware of any material that may be disrupting the magnetic field in the vicinity during
calibration as this may skew the directionality of your data. This is likely to occur at magnetic fields
stronger than 5 Gauss. Velocities with respect to X Y and Z and according to each beam will be
correct but North, East and Up may be incorrect. If possible, do the final calibration before you board
your vessel as ship decks tend to hawe non-uniform magnetic disturbances significant enough to
disrupt the compass calibration process.

Note: Do not subject any part of the instrument, including batteries, to a magnetic field stronger than
20 Gauss. This may permanently damage the components and cause irreversible damage to the
compass.

The raw data from the magnetometer and accelerometer are stored every time the compass direction
is read. From a practical point of view this means that any instrument that has spun 360 degrees
during a deployment can be calibrated for hard iron effects in post processing so long as you have
the Ocean Contour software. This awids the problem of calibrating the compass before deployment
and in principle makes it possible to achieve higher directional accuracy in the current velocity data.

Magnetic Declination

The compass calibration does not correct for magnetic declination at the deployment site. This must
be added either before the deployment using commands (see the Integrators Guide), or after the
deployment when post-processing in Ocean Contour.

Before Deployment

With the previous sections of this chapter successfully completed you are now ready for your final
preparations before deployment.

e We recommend that you carefully plan the deployment setup and make yourself aware of the
possibilities in the Nortek Deployment software. Simply select Planning > Deployment
Planning to open the deployment settings. Here you are able to configure the settings without
needing a live connection with your instrument. Set the deployment configuration as desired and
click Save configuration. This will allow you to quickly load the settings onto multiple
instruments and keep equivalent deployment settings time after time.

e For stand alone systems, it is \ital to remember to connect the dummy plug to ensure the
instrument is water tight. Before mating, ensure that the connectors are dry and free of debris, look
for water inside the female connector.

e When properly mated, the engaging nut on the cable plug will thread smoothly onto the receptacle
shell until it rather abruptly reaches a point where it cannot be hand-tightened any further. At this
point the mating surfaces of the plug and receptacle are in contact, and have formed a good seal.
The amount of force required to tighten the engaging nut should stay the same throughout (up until
the point where it cannot be further hand-tightened). Otherwise, the connectors are not mating
properly and will not form a good seal.

e Set a pressure offset. The instrument measures absolute pressure, and the pressure offset
selected is the pressure reading for offsetting absolute to relative pressure. The factory setting is
9.5 dBar; this is chosen so that you always see a non-zero reading when the instrument is in air
and can verify that the pressure sensor is functioning correctly. For reference, atmospheric
pressure usually fluctuates around 10.13 dBar, and 1 dBar is equivalent to the pressure change
over 1m depth in fresh water (so at 1m depth the absolute pressure would be 11.13 dBar).
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¢ We recommend starting new deployments with an empty memory. Before you erase the recorder,
make sure that you have transferred all the data you want to retain. Click Deployment >
Recorder Data Retrieval > Erase Recorder. If the SD-card becomes full during deployment, the
data will stop being written/saved. But it will continue to measure in case serial output is turned on.

¢ Depending on when you set your deployment start time it can be wise to check that the instrument
has started sampling as planned. This can be done by checking the LED which will blink every
time a ping is sent by the instrument.

e Be aware that if the deployment time has passed when the battery is connected, the instrument
will resynchronize its data sampling according to the deployment time and the instrument
configuration. This means you may have to wait for one average measurement interval or one burst
measurement interval before the instrument starts to ping. When the instrument re-synchronizes, it
will blink the LED once just after the battery is connected.

Example: the deployment is set to start at 12:00 with 20 minute measurements intervals, but the
battery is connected at 12:10, the first measurement interval will start at 12:20.

e If you are using an internal and external battery the primary battery will be selected based on
which has highest voltage.

¢ We recommend starting a deployment with fresh batteries. But if you want to estimate how much
is left of a used battery the best way is to use the estimates given by the Deployment Software.
For example: The internal batteries for the Signature500 are 180Wh. The last deployment lasted for
126 days and were using approximately 0.7Wh per day (this information can be found in the saved
.deploy file). Then the remaining Wh of the battery is thus 180-88 ~ 90Wh

¢ O-rings for the online connectors should be lubricated with silicone lubricant.

It is worth double checking your deployment settings and the structural integrity of your rig before
deploying the instrument.
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51

Software

The Deployment software has been designed to aid you in the planning, execution, recovery, retrieval
and conwersion of data collected. In addition to the information below, a description of the various
elements on the screen (parameters, buttons etc.) will appear if you hover over the element in
question (mouse-over-text).

The newest Deployment Software version is always available for download from our website; check
out the Installing Software section for more details.

Discovery Tool

The Discover configuration menu selection provides a means to locate and configure the network

information for instruments without having to know the IP address of the instrument. All instruments

found on the network are displayed.

¢ Highlight the instrument you want to connect to and double-click/use the Connect button.

¢ If you use a static IP address you can type it directly into the Discovery dialog and click Connect.

¢ If you connect to the instrument using serial cable, check the "Serial Port" box, select the correct
communication port and baud rate. The default is 9600. Note that the latter will let you
communicate with the instrument through the terminal window only.

Note that it may not be possible to "discover" instruments on networks that are connected to the
local network through a router. Read more about this in the Troubleshooting chapter.

Connect to instrument

Nickname Instrument Senal number Frequency Firmware Connection

Nortek-bench Signature1000 1001 1000 7022 4 169.254.244.9

Discover

IP address ).0 [ | Serial port Baud rate

Figure 10. Discovery dialog box

¢ Instruments shown in the list that have a gray background will be possible to connect to.
¢ Only one person can be connected to an instrument at a time. If you try to establish connection
with an occupied instrument, you will receive a notification.
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¢ If an instrument has a red background, a notification box will give you information regarding the
error. Refer to Software Problem chapter for information.

Right-click the highlighted instrument to get the option of using the Terminal Emulator (or press
Ctrl+T, consult Appendix if needed). In the menu you also have the possibility to open the instrument
specific web site or show the instrument logs (Deployment log, Instrument log, System log and SEC
[Serial Ethernet Connectivity] log). There is also an alternative called "Network Configuration”, which
enables the possibility to enable/disable DHCP or set the IP address. The latter option is described
in detail here.

Deployment Wizard

The instrument is configured by clicking the Plan button or clicking Planning > Deployment
planning in the menu line. The Deployment Planning is structured as a wizard which guides you
through the necessary steps to configure the instrument successfully. It is possible to configure the
settings for your deployment file without a live connection with your instrument.

The Deployment Wizard view is divided into three parts; Steps, Instrument and Effect (refer to
screenshot below). The idea is that you follow the steps using the Next button (and Back, if you
need to) and make the adjustments from the default options. The first three steps; Instrument,
Application and Environment define the physical settings of the instrument. The remaining steps
determine how and when the instrument measures. When you change the settings in one step, the
default values in the following steps will also be adjusted.

The Effect field displays performance parameters that are automatically updated as you change the
parameter settings. It is a good idea to keep an eye on the Effect during the planning, to make sure
you do not violate e.g. required precision of the data, power consumption or memory available.
Parameters that are highlighted in yellow are meant to serve as notifications and warnings to the
user. An explanatory tooltip will be displayed if the mouse is hovered over the parameter.

The planning will result in a Deployment file (.deploy). The instrument can be started directly from the
Deployment Wizard (if you are connected to an instrument) by using Deploy or Start Online
buttons. The .deploy file can be saved and then uploaded to the instrument before deployment, and
this option will allow you to quickly load the settings onto multiple instruments and keep equivalent
deployment settings time after time. The Customize option lets you sawe the file and open it in a text
editor for further customization.
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Deployment wizard

Steps

1. Instrument Type

®) Signature55
Signature100
Signature100-DW
Signature100-LADCP
Signature250
Signature500
Signature500-DW
Signature1000
Signature1000-DW

Recorder
Deployment R 15 e

Length (days) 3012

Internal battery capacity

Alkaline 540 Wh

External battery capacity
None 0 Wh

Instrument

Licensed features

Open Customize ‘

Figure 11. Deployment planning, step 1.

Configuration

Name

~ Performance
Configured length (days)
Estimated max length (days)
Battery capacity (Wh)
Power usage (Wh)
Recorder capacity (MB)
Memory usage (MB)

 Data sampling
Power level (dB)
Long range mode
Multiplexing
Number of pings

~ Slanted beams
Horizontal prec. (cm/s)
Vertical prec. (cm/s)
Velocity range (m/s)

» Vertical beams
Vertical prec. (cm/s)

Velocity range (m/s)

Coarse profile

30

60

540
2699
15258.8
314

Before going into the details of each step, here is an overview of the different parts of the Effect and

Summary.

Effect

Performance

Configured length Number of days you would like to collect data. This value, together with the
(days) other deployment parameters and the hardware configuration, will be used for
calculating the performance parameters, i.e. power usage, recorder memory

requirements and velocity precision.

Estimated
length (days)

Battery
(Wh)

Power usage (Wh) The estimated power requirements as calculated by the firmware.

capacity Total watt-hours as determined by the user.

Recorder capacity If no instrument connected; total capacity of the recorder in MB.

(MB)
Recorder
space (MB)
Memory
(MB)

Data sampling

free If instrument connected; unused space on the recorder in MB.

max The deployment duration based on measurement parameters, hardware
configuration and configured number of days.

usage The estimated memory requirements as calculated by the firmware.

Power level (dB): Relative dB scale, where maximum power level is -3 dB. The maximum
allowed power level varies with the configured profile range.

Long range mode On or Off, varies with user requirements for range. In long range mode, more
pings are required to reach the same velocity precision.
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Multiplexing Only applicable for Signature250/100/55. Threshold at -6dB for on/off

Number of pings The number of pings to be averaged together during the averaging interval.
Important for velocity precision.

Slanted/vertical beams

Horizontal prec. A theoretical estimate of the precision of the velocity measurements based on

(cml/s) how the instrument is set up. As a rule of thumb, this should be lower than
1/10 of the expected \elocities in the measurement area.

Vertical prec. A theoretical estimate of the precision of the velocity measurements based on
(cm/s) how the instrument is set up.

Velocity range Maximum along-beam measurable velocity. Velocity range should cover the
(m/s) range of the welocities anticipated during the deployment. A welocity range set

too high may result in more noisy data, and too low will mean that you will not
be able to measure the highest welocities. If a range is set too short, it will
result in velocity wrapping. This is based on the selected mounting method.

Measurement range

Desired range (m) Calculated based on instrument depth, up/down orientation and end of profile.
Configured range Calculated based on end of profile and cell size.

(m)

Estimated range Theoretical estimate. Based on "Geography", end of profile, cell size, power
(m) level and long range mode.

Blanking distance Blanking is the time during which no measurements take place, to give the
(m) transducers time to settle before the transmitted signal returns to the receiver.

This blanking reduce the interference from ringing based on the selected "Start
of profile (m)"

Cell size (m) Specifies the vertical length of each depth cell in the profile. Standard deviation
of the welocity measurements is inversely proportional to the depth cell size
(larger depth cells give smaller standard deviations).

Number of cells Number of depth cells to collect per profile. The maximum number of depth
cells with accurate velocity data will vary with system frequency, depth cell
size and deployment conditions

Number of beams Number of active beams with selected configuration.

Altimeter OFF
Ice drift OFF
Pulse distance n/a

Altimeter start (m) n/a
Altimeter end (m) n/a

Sampling rate

Measurement Describes how often the instrument will collect data.

interval

Configured Specifies how long the instrument will be actively collecting data within each
average interval Measurement interval

Actual average Specifies how long the instrument will be collecting data within each
interval Measurement interval. Differs from the Awerage Interval to allocate the Number

of Pings correctly within it.
Sampling rate (Hz) n/a
#Samples n/a
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Burst duration (s) n/a

Summary presents a summary of the deployment based on the selections made. Some parameters
are presented in the previous table.

Performance

Min configured baud The minimum required baud rate, based on the amount of data being
rate transferred (in turn based on measurement plan, number of cells, etc.)

Max RS422 cable The maximum length of an RS422 cable that can be used, based on the
distance (m) configured baud range

System information

Instrument name Type of instrument, e.g. Signature1000
Nickname The identifier given to this particular instrument
Serial number The serial number of the instrument

Head frequency (Hz) The frequency of the transducers on the head

Opt. sensors Any additional sensors that have been added, e.g. AHRS

Firmware version The currently installed firmware version

Recorder size (GB) The size of the installed and licensed recorder

Connection If Ethernet: IP address of instrument. If Serial: connected COM port.
Orientation How the instrument is determining its orientation, e.g. Auto Z up/down

Application (see below for definitions)
Environment (see below for definitions)

[chosen measurement regime] (see below for definitions)

Step 1. Instrument. Refer to screenshot abowe.

e Select the type of instrument that shall be used. If the Signature is connected, that will be the only
alternative available. Licensed features available for this particular instrument will be listed, the
same applies to the Recorder.

e Licenses: Awvailable functions. Contact Nortek if your measurements require other licenses.

¢ Recorder Capacity: Lists the recorder options.

e Sensors: AHRS (Attitude, Heading, Reference Sensor - requires additional hardware). Enable if the
instrument is to be deployed in a dynamic environment.

e Deployment length (days): Enter the number of days you would like to collect data. This value,
together with the other deployment parameters and the hardware configuration, will be used for
calculating the performance parameters, i.e. battery utilization and recorder memory requirements.

¢ Specify the type of battery used (does not apply for online deployments). This is used to calculate
Power usage.

Step 2. Application. Select between Single, Concurrent or Alternating plans.

¢ Single plans means that the instrument will measure using the same measurement interval,
average interval, etc. (see parameters in step 4) during the entire deployment. Fine profile means
that the instrument will have Long range mode off, Coarse means on.

e Concurrent plans (for Signature100) enable different sampling schemes at the same time.

¢ Alternating plans (for Signature55) enables the possibility of alternating the sampling regime during
deployment at a specified ratio. This can be used if you want long range (coarse profiles), but are
also interested in a fine resolution. The solution is to alternate between Fine and Coarse
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Resolution at a specified rate. The range, cell size and sampling rate for the two profiles can be
customized separately. See example of measurement sequence below.

[ Fine [ Fine [ Fine [ Fine [ Fine [ Fine [ Fine [ Fine [ Fine |

Al B AL A ALl AL A ALl AN
[ Coarse [ Coarse [ |

YW Measurement interval, fine resolution

Il Measurement interval, coarse resolution

Average interval, fine resolution

Average interval, coarse resolution

[T Idle

Figure 12. Visualization of an alternating plan deployment setup. Ml = Measurement Interval, Al =
Averaging Interval.

Deployment wizard

Steps Application

1. Instrument Single plans Configuration

2. Application Average - Fine profile Name Coarse profile
®) Average - Coarse profile  Posformance
e e Col:lﬁgured length (days) 30
Estimated max length (days) 60
Average - Fine profile Average - Coarse profile Battery capacity (Wh) 540
Power usage (Wh) 269.9
Recorder capacity (MB) 15258.8
Memory usage (MB) 314
» Data sampling
Power level (dB)
Long range mode
Deployment Multiplexing
Number of pings

Length (days) 302 ~ Slanted beams

Horizontal prec. (cm/s)
Internal battery capacity

Alkaline 540 Wh

Vertical prec. (cm/s)
Velocity range (m/s)

External battery capacity ~ Vertical beams

W Vertical prec, (cm/s)
Velocity range (m/s)

Open Customize

Figure 13. Deployment planning, step 2.

Step 3. Environment.

e Sound Velocity: Speed of sound can be set by the user (Fixed) or calculated by the instrument
based on the measured temperature and a user-input value for salinity. The salinity is 0 for fresh
water and typically 35 for the ocean. The instrument use the speed of sound at the depth of the
transducer to scale the Doppler frequency shift to velocity.

e Deployment: Specify if the instrument is looking upward or downward during the deployment, and
estimate the distance to the bottom/surface. If the surface or the bottom is within the range of the
instrument, this distance is used to configure the profiling range.

e Mounting: Choose the settings that best fits your deployment, which affects the velocity range.

Velocity range: The velocity range reported by the Deployment software is the along-beam velocity
range, which translates to a horizontal velocity range of VR/sin(6), where VR is the reported along-
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beam velocity range and 6 is the beam slant angle. For example, a Signature1000 with a VR of 5
m/s and a slant angle of 25° will have a horizontal velocity range of +11.83 m/s.

Deployment wizard

Steps

1. Instrument
2. Application

3. Environment

Deployment

Length {days) 3012

Internal battery capacity
Alkaline 540 Wh

External battery capacity

None 0 Wh

Open

Environment

Sound velocity Deployment

Fixed (m/s)
®) Measured
Salinity (ppt) 3515

®) Up-looking orientation
Down-looking orientation

Mounting
e Fixed frame

Subsurface buoy
Surface buoy

Customize

Instrument depth (m) | 10002

Configuration

Name

~ Performance
Configured length (days)
Estimated max length {days)
Battery capacity (Wh)
Power usage (Wh)
Recorder capacity (MB)
Memory usage (MB)

~ Data sampling
Power level (dB)
Long range mode
Multiplexing
Number of pings

a Slanted beams
Horizontal prec. (cm/s)
Vertical prec. (cm/s)
Velocity range (m/s)

~ Vertical beams
Vertical prec. (cm/s)

Velocity range (m/s)

Coarse profile

60

340
2609
15258.8
314

Figure 14. Deployment planning, step 3.

Step 4. Average / Fine Profile / Coarse profile. The header of this step depends on the selected
plan in the Application step.

e Range: The instrument measurement region starts at Start of Profile (meter from the transducer)
and ends at End of Profile. The Start of Profile defines the blanking distance. Cell size is the size
of the individual cells in the profile, in meters. A larger cell size transmits more energy for a given
power level. Power level should be set to match the desired Estimated max range or exceed it with
a desired margin.

e Sampling: Averaging interval specifies how long the instrument will be actively collecting data
within each Measurement interval. Example: Measurement Interval is set to 600 seconds,
averaging interval set to 60 seconds means that the instrument will collect data for 1 minute every
10 minutes. Averaging Interval must be smaller than or equal to Measurement Interval.
Measurement load: Within each second, the instrument can either be in active mode (collecting
data) or in idle mode (not collecting data). The Measurement load is the relative time spent in
active mode within each second and can have value from minimum (one ping) to 100% (always in
active mode). With the Auto option selected, the program will automatically calculate an
appropriate measurement load based on the averaging interval. Measurement load should be used
a configurable trade-off between precision and battery usage.

¢ Options: Select coordinate system as desired (BEAM/XYZ/ENU). Changing the coordinate system
can always be done as a post-processing step also. Telemetry data format determines if serial
output is enabled and which format is used. Read more about the telemetry file in our System
Integrator's Guide.
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Deployment wizard

Steps Coarse profile

- Instrument Range ( min - max ) Configuration

b e start of profile (m) Al (2-1000) Name Coarse profile

3. Environment End of profile (m) {2-1185) A Performance
Coarse profile eelemaln ) 2 (=, Configured length (days) £
Power level max -3.0dB Estimated max length (days) 60
Battery capacity (Wh) 540
Sampling (min - max) Power usage (Wh) 2699
< Back .
Average interval (s) A {6 -1800) Recorder capacity (MB} 15258.8
Measurement interval : {00:00:06 - 02:00:00 ) Memory usage (MB) 314
Measurement load  min « | max 100.0 % [v] Auto  Data sampling
Power level (dB)
Options Long range mode
Deployment Multiplexing

Coordinate system
Number of pings

= Telemetry data format :
Length (days) 3002 L L Enable serial output A Slanted beams

Horizontal prec. (cm/s)
Internal battery capacity

Alkaline 540 Wh

Vertical prec. (cm/s)
Velocity range (m/s)

External battery capacity  Vertical beams

None 0 Wh Vertical prec. (cm/s)

Velocity range (m/s)
Open Customize |

Figure 15. Deployment planning, step 4.

Step 5. Coarse profile (if applicable).
See explanations from previous step.

Step 6. Echo Sounder: Relevant for Signature100
e Range

o The measurement region starts at Start of Profile (meter from the transducer) and ends at End of
Profile. The Start of Profile defines the blanking distance

o Cell size is the vertical size of the individual cells in the profile, in meters. A larger cell size will
make the instrument transmit more energy for a given power level.

e Echogram (1, 2 and 3)

o Echogram can be combined so that the instrument measures both with and without pulse
compression, or with different strength on the transmit pulse (transmit length). It is possible to
enable three Echograms, but only one of them may be using Pulse compression. If unsure about
what to select, it can often be a good idea to enable one echogram without pulse compression
and another echogram with pulse compression enabled. Then you get both results at the same
time and can decide later which one to use.

o Frequency: 70kHz, 90kHz and 120kHz echograms available, each with individually configurable
transmit length and power level. Pulse compression only available on 90kHz.

o Transmit length with pulse compression: Changing the transmit pulse length when using pulse
compression can increase the SNR at the expense of the power consumption. The resolution is
not affected at the bin size will be equal to the configured value. Note that pulse compression
may in some circumstances suffer from side lobe effects but generally, this is not a problem.
Without pulse compression: The length of return echo will be a conwlution of the rectangular
transmit pulse and receive window. If the transmit pulse length is set to bin size/(c/2) or
nominally bin size/750, the bins will consist of triangularly weighted echoes, similar to the
classical ADCP bins. In this case the resolution depends on both the length of the transmit
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pulse and the bin size. The best resolution is achieved with the shortest allowable transmit pulse
but still limited by the bandwidth.

e Sampling

o Interval: Specifies how often to repeat a echo sounder measurement. There are options to specify
the sampling of each Echogram (if enabled) and also enable storing raw echo data on the recorder.

Deployment wizard

Steps

. Instrument

. Application
3. Environment

. Echo Sounder

. Echo Interval

Deployment

Length (days) 3012

Internal battery capacity
Alkaline 1080 wh

External battery capacity

None 0 Wh

Open

Range

Start of profile (m)
End of profile (m)
Cell size (m)

Echogram 1
Frequency (kHz)
Bins

Transmit length (ms)

Power level

Echogram 2
Frequency (kHz)

Transmit length {ms)
Power level

Echogram 3
Frequency (kHz)

Transmit length (ms)
Power level

Figure 16. Deployment planning, step 4.

Final step: Deployment

Echo Sounder

(min - max )
(2-200)
(2-409)
(0375-4)

¥| Pulse compression

Enable

Disable

|| Enable

Disable -

Customize

Configuration

Name

» Performance
Configured length (days)
Estimated max length (days)
Battery capacity (Wh)
Power usage (Wh)
Recorder capacity (MB)
Memory usage (MB)

» Data sampling
Power level (dB)
Long range mode
Multiplexing
Number of pings

a Slanted beams
Horizontal prec. (cm/s)
Vertical prec. (cm/s)
Velocity range (m/s)

» Measurement range
Desired range (m)

Configured range (m)

EchoSounder

30
1747
1080
1854
15258.8
2618.6

07 _/_
nfa
nfa

1

nfa
nfa

nfa

When you are finished with the wizard, the configuration you have prepared must be saved as a
deployment file. Define a name for the Deployment file you have prepared and add comments. The
File menu configures where and how data are to be saved to the disk. The default filename is as
follows: AD2CP_Instrumentfrequency_serialNO_DeploymentName.deploy.
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Stand-Alone Deployment

Deployment Summary

Configuration  Summary

Name

A Performance
Configured length (days)
Estimated max length (days)
Battery capacity (Wh)
Power usage (Wh)
Recorder free space (MB)
Memory usage (MB)

A Data sampling
Power level (dB)

Long range mode
Multiplexing
Number of pings

A Slanted beams.
Horizontal prec. (cm/s)
Vertical prec. (cm/s)
Velocity range (my/s)

~ Vertical beams
Vertical prec. (cmy/s)
Velocity range (m/s)

 Measurement range
Desired range (m)
Configured range (m)
Estimated range {m)
Blanking distance {m)
Cell size {m)

Number of cells
Number of beams
Altimeter

Ice drift

Pulse distance
Altimeter start (m)
Altimeter end {m)

» Sampling rate
Measurement interval
Configured average interval
Actual average interval
Sampling rate (Hz}
#5amples

Burst duration (s)

Average Burst 1-4

87
90
14

0.2
1

21
4
OFF
OFF
nfa
nfa

nfa

00:10:00

00:02:00

00:01:57

nfa 4

nfa 4096
nfa 00:17:04

Deploymentname [ unset |

Deployment time

Now

Synchrenize clock to PC time

Deploy

Cancel

Figure 17. Deployment summary. The
highligh presents relevant information

31

A deployment sequence is started by clicking the Deploy button, and you will be prompted to select
which deployment file to use. This activates a summary of the configuration:

¢ Read through and \erify that the set-up is as intended. This dialog box will confirm the selections
made in the Deployment Wizard.
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e The Deployment Name is by default the same as set in the final step of the Deployment Wizard,
but it is possible to rename it.

e If you want the deployment to start some time in the future, set the date and time in the
Deployment time field.

e The synchronize clock to PC time sets the instrument clock to the same as the PC clock. The
purpose is to set the time as correctly as possible. The time reference is especially important in
order to ensure proper synchronization between the instrument and other data sets collected
independently. Time spent to properly set the time before a deployment can sawe a lot of time in
post processing and analysis.

e The LED can be set to blink for every sample (On), blink for the first 24 hours of deployment (On for
24h), or never (Off).

e Press Deploy to send the configuration to the instrument.

The instrument connection will be closed during data collection, and you will be sent back to the
Disconnected View of the software. The instrument is now properly configured and will stay in sleep
mode until it begins its deployment at the scheduled time.

To stop the deployment, click Connect. Find the instrument in the Discovery feature and click the
instrument you want to connect to. A notification will warn you that connecting to the instrument will
stop data collection.

Be aware that if the deployment time has passed when the battery is connected, the instrument will
resynchronize its data sampling according to the deployment time and the instrument configuration.
This means you may have to wait for one average measurement interval or one burst measurement
interval before the instrument starts to ping. When the instrument re-synchronizes, it will blink the
LED once just after the battery is connected.

Example: the deployment is set to start at 12:00 with 20 minute measurements intervals, but the
battery is connected at 12:10, the first measurement interval will start at 12:20.
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Online Data Collection

An online measurement sequence is started by clicking the Start button, and you will be prompted
to select which deployment file to use. Data collection will start immediately after the selected
deploy file has been opened. After data collection has started, the Stop data collection is enabled.

If you want to record the online data, make sure to select Record Data under the Online menu
before clicking Start. Otherwise, data are not saved on the recorder nor the computer hard drive
during data collection. To find the data recorded to disk, click File > Open Online Data Folder.

The online data collection functionality in the SignatureDeployment software is intended mainly for
function testing. For long-term deployments with real-time data output, enable data telemetry over the
communications line using commands (see the Signature Integrator's Guide).

The online display window shows profiling and time series graphs for data currently collected by the
instrument. Refer to screenshot below. The main display consists of two resizeable panes. The top
pane contains multiple tabular listings of measurement and status data. The bottom pane contains
multiple chart and sweep plots of the measurement data. Different display groups are divided into
tabbed windows to provide better viewing of the data. Use the time series row to select which data to
display; either showing one cell at a time or a profile of one of the beams at a time. Certain data
elements are displayed in a text pane. This displayed data is picked up live from the data stream as
it is being collected (so no changes will be seen in this pane unless data collection is proceeding).

Menu
Sensor data,
timing and
ensemble
counter
Toolbar —<
Profile and
[— time-series

chart

System
information

&

Figure 18. Overview of the main screen. This screenshot is from a Signature1000 in air.
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5.5

Recorder Data Retrieval

The Data Retrieval dialog box shows a list of all files currently stored in the recorder, including the
time of the first measurement and the size for each file. The .cfg is the configuration file, the .ad2cp
contain all raw data, stored in binary format. To allow the user to quickly investigate the results
without having to download the full raw data file ([flename].ad2cp), an additional data file is stored
containing only the averaged current data ([filename]_awvgd.ad2cp). Only data where the correlation is
above 50% will be included in the averaging, and the data will also include a percent-good value. Any
bad data will be removed, or flagged with extreme values (e.g. -32.77 m/s). This averaging is only
applicable to average mode; burst data will not be processed in this manner. "Percent Good" is
defined as the percentage of data points above 50% correlation that go into an average ensembile.

Click the magnifying glass to see a summary of the deployment. Then download either all data (white
arrow), or just the internally aweraged data (_awgd.ad2cp file, dark gray arrow). The raw data
downloads all single ping data. The file will be savwed by default in the folder named
Users\UsenDocuments\Nortek\Deployment\Downloads, but this can be changed if needed. Multiple
files can be downloaded at the same time. The "Show all" check box can be checked off if you want
to see all files available on the recorder.

The firmware splits each deployment into 1 GB files, which are merged together when you download
them. The "Download All" button will retrieve everything from the recorder but will not merge the files.
You will need to use the white or gray arrows. It is not possible to change the maximum file size.

Erase Recorder

Click Deployment > Recorder Data Retrieval > Erase Recorder. It is good routine to do this in
advance of every deployment as we recommend starting new deployments with an empty memory.
Erase Recorder deletes the File Allocation Table (the list of files). This means that the data are not
erased, they are made re-writeable. There is also the option to reformat the recorder under
Instrument > Format Recorder which will delete everything on the recorder.

Note: Before you erase the recorder, make sure that you have transferred all the data you want to
retain.
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Recorder Data Retrieval m}

Instrument files Show all

Download  Deployment Date Size Included file types
S001001A037 testing  2021-02-1615:52 1.00MB  ad2ep | cfg | deploy
S001001A038 unset  2021-02-1809:00 116 KB  ad2cp | avgd | cfg | deploy

Save in folder:

C\Users\user\OneDrive - Nortek AS\Documents\Nortek\Deployment\Downloads

Download All Erase Recorder

Figure 19. Recorder data retrieval dialog box

To find the downloaded data, click File > Open Deployment Data Folder or click the link in the
dialog.
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5.6

Data Conversion

The Data conwersion menu is used to conwert the proprietary binary data files (.ad2cp) into various
formats. Multiple data files can be selected and conwverted at one time. Click Add File... This
displays a file selection dialog box where you can select files to add to the Files to convert list.
Press Start to initiate the conversion process. The converted data are located in the folder specified
under "Sawe in folder". This path is also clickable.

Export to Matlab format result in .mat files which are directly readable by MATLAB. There is also an
option to Export to .PD0 format which convert the file to standard PDO binary format, or Export to
CSV format which can easily be used with Excel. It is possible to select Include coordinate
transformations which will automatically calculate the remaining two coordinate systems (e.qg. if you
chose ENU, then BEAM and XYZ coordinates will be included). Note that this will approximately
triple the file size. The "Use 3D profile arrays" result in data saved in 3D arrays instead of 2D (which
is the default).

Data Conversion

Name

Save in folder
Ci\Users\user\OneDrnive - Nortek AS\Documents\Nortek\Deployment\Converted
|#| Export to Matlab format | | Coordinate transformations | 3D profile arrays [ | Compress

| | Export to PDO format

| Export to CSV format Separator Coordinate system

Add file... Remove all

Figure 20. Data conversion dialog box
Data Format

.ad2cp and .cfg
The format of these data files are described in the System Integrator's Guide. The .cfg is the
configuration file, the .ad2cp contain all raw data, stored in binary format.

.mat

Four structures are created. Data and Config contain sub-structures, Comments and Units that
provide text describing the contents of the structures. Note that this operation can result in large
amounts of RAM being used when processing large data files. Large data files will be broken down
into multiple smaller .mat files by the export process. When multiple files are produced, “ #’ will be
added on to the file name prefix to identify each file portion.

.pd0

RDI Workhorse pd0 data format. See RDI documentation for details.
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.CsV
Comma separated values format. Each line is a data record, each column is described with the
relevant header. Exports averaged data only for both raw .ad2cp files and _avgd.ad2cp files.

In order to get manageable file sizes out of the data conversion, there is a constraint of 50 Mb per
file. The result is that the .ad2cp file will be separated into a number of sub files during conversion,
depending on selected exported format and data size:

.mat and .pd0: Exports raw and aweraged data, and these two types of files will be separated by an
_awvgd extension on the averaged data file. Large data files will be broken down into multiple smaller
files, and _# will be added on to the file name prefix to identify each file portion.

.csv. Exports only averaged data, and the exported files will be separated into subfiles based on the
configuration. For example, if you measure Current Profile and Burst, you can expect to get files with
A0 and BO in their names, respectively. If you in addition measure with alternating modes, you will
see A0, A1, BO, B1. A0 and BO contain Current Profiles and Burst data from the content of
Alternating plan number one, and A1 and B1 is the Current Profile and Burst data from Alternating
plan number 2. Other file identifiers are IBO to denote Burst data from the vertical beam, and RABO to
denote raw altimeter burst data. In addition, large data files will be broken down into multiple smaller
files, and _# will be added on to the file name prefix to identify each file portion.

Note that the above may not be relevant for your specific instrument. The Signature250 does not have
the option of alternating between two modes, and the Signature55 does not have concurrent
measurement plans.
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5.7

5.8

5.8.1

5.8.2

5.8.3

Post-Processing

The raw measurements captured by ADCPs often need to go through post-processing to yield usable
datasets. The post-processing software intended for the Signature series of instruments is called
Ocean Contour, and requires a paid-for license. If you would like a quote for the software, please
contact your local Nortek representative. Once you have a license, the software can be download
from our website.

Ocean Contour is a standalone, interactive desktop application that provides data visualization and
processing capabilities for acoustic Doppler systems, specifically Nortek's Signature series, other
AD2CP based instruments, and the Vectrino Profiler. Ocean Contour provides interactive QA/QC,
data awveraging and wawve processing in addition to the display of all data products from the supported
instruments.

Menus

The following commands are available on the main menu:

File

Open Documents Folder

Starts the Windows Explorer in order to find the folder where all the data files are stored.

Open Deployment Data Folder
Starts the Windows Explorer in order to find the folder where all the deployment data files are stored.

Open Online Data Folder
Starts the Windows Explorer in order to find the folder where all the online data files are stored.

Preferences
Sets the user data location and toggle for tooltips.

Exit
Disconnects from all instruments and exits from the application.
Communication

Connect to instrument
Initiates the Discovery feature which allows instruments to be found on the local network.

Disconnect from instrument
Disconnect instrument and returns the software to the startup screen.

Terminal Window
Access the Terminal Emulator to communicate directly with the instrument using commands. A
simpler way to access the terminal emulator is to click Ctrl+T in the Discovery screen.

Open in Web browser
The AD2CP network processor runs a web server for displaying basic information about the
instrument. To access the Web site, click here.

Planning

Recent deployments
Select a recently used deployment file.

New deployment
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5.8.4

5.8.5

5.8.6

Starts the Deployment Planning wizard.

Open deployment
Opens the location where deployment files are saved.

Deployment

Start recorder deployment

Initiates a deployment after selecting your .deploy file. Data will be stored on the instruments internal
memory card.

Recorder data retrieval
After a recorder deployment the data (.cfg and .ad2cp file) will be available on the recorder for
download.

Data conversion
The Data conversion menu is used to convert the proprietary binary data files (.ad2cp) into Matlab file
format. Multiple data files can be selected and converted at one time.

Online

Start Data Collection
An online measurement sequence is started by selecting your .deploy file. Data is collected over the
Ethernet or serial cable and can be seen in the Deployment software in real time.

Stop Data Collection
Stops online data collection.

Record Data
Enable before starting data collection if you want the online data to be recorded to disk.

Instrument

Nickname
Opens a text field to enter a (new) nickname.

Compass Calibration
Use this command to display the Compass Calibration dialog box that allows perform an on-site 2D
or 3D calibration of the instrument compass to remowe the effect of Hard-iron objects.

Firmware Upgrade

Use this command to download new firmware to the instrument. When upgrading the firmware, check

to ensure that the most recent version of the application software is also used. Incompatible firmware

loads will be detected by application.

1. Download the newest firmware to your computer from here: http://www.nortek-
as.com/en/support/software

2. Click on Upgrade, select the relevant instrument and then browse to the downloaded firmware file
and select it.

3. Click OK to start downloading the file to the instrument. This will result in the file being transferred
to the instrument and a progress bar will be displayed

Erase Recorder
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Deletes the File Allocation Table (the list of files). This means that the data are not erased
completely, they are made re-writeable.
Format Recorder
This option will erase the recorder completely, not just the FAT as described abowve.
Set Pressure Offset
Set the pressure offset in dBar
Licenses
Add a new license to increase the available functions.
Show log
Use this command to display or edit the deployment log file.
Get Support File
Download the instrument support file (.tar.gz) containing debug information. This file is useful if you
need support.

5.8.7 Help
Help

Offers you an index to topics on which you can get help.

Manual
PDF versions of the Signature55/100 and Signature250/500/1000 operations manuals.

Release Notes
Open the software version release notes in your default text viewer.

Firmware release notes
Open the firmware version release notes in your default text viewer.

Nortek Web site
Open the Nortek home page in your web browser.

Check for updates
Check for more recent firmware or software versions, and select if this shall be done automatically.

Download Firmware
The firmware is bundled with the software.

Support Files
Download the software support file (.txt) containing debug information. This file is useful if you need
support.

About
This item provides information about Nortek and how to contact us.
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6.1

Mechanical Aspects and Maintenance

Preventive maintenance is your primary tool to keep your instrument in shape and ready for action
and deployment. We recommend a regularly scheduled procedure which will act as a preventative
measure to ensure your instrument continues functioning as intended. The following sections can be
used as a maintenance guideline for the components that may be exposed to wear and tear.

We recommend conducting a Functionality Test after the maintenance procedure has been finished,
to ensure that the instruments functionality is as expected. For AD2CP instruments, we also
recommend adding an entry in the internal log that is kept within the instrument. This can be helpful
in assessing senice intervals etc. The "Add Deployment Log Entry" box on the Logs tab in the web
interface can be used for this. This log will also keep a record of things like formatting or erasing the
recorder and firmware upgrades.

DO NOT EXPOSE THE ELECTRONICS

In general, there should be no reason to expose the instrument electronics. Do not open the
housing to expose the electronics unless instructed by Nortek.

Only qualified personnel are allowed to perform corrective maintenance activities. Please contact
Nortek for further assistance if in any doubt.

Instrument Care

All Nortek instruments are intended for use in water. Other fluids may have an adverse effect on the
materials used.

For prolonged storage at elevated temperatures close to the specified limit, or when temperature
variation is uncertain, it is recommended that the screws securing the end cap be loosened in order
to minimize the risk of any deformation due to temperature/stress over time (if your instrument has
an accessible pressure case).

A preventive maintenance routine should include regular cleaning of the instrument. Use a mild
detergent and pay special attention to the transducers. Do not expose any part of the instrument to
harsh chemicals. Check the pressure sensor and remove any dirt from the holes in the cap. Be
careful when opening the pressure sensor cap as it is easy to dent the sensor.

Do not use the molded head or endbell as a clamping surface, always clamp to the instrument
housing.

When opening the instrument, great care should be taken to keep the sealing surfaces clean and
protected from mechanical damage. Keep water out of the open pressure case. Both fresh and salt
water can corrode the circuitry.

If the instrument has been subjected to environmental conditions outside the specified design limits
(refer to the Technical Specification for your instrument for the limits), mechanical tolerances of non-
metal components may be affected.

Nortek AS


mailto:support@nortekgroup.com
mailto:support@nortekgroup.com
https://www.nortekgroup.com/products

42

Signature Series Operations Manual

6.2

6.3

6.4

6.5

Connector Care

It is extremely important to keep connectors clean and well lubricated. Before plugging in connectors
we recommend to always blast the pins with compressed air, inspect them for cleanliness and then
protect the cable connector by applying a thin layer of silicone lubricating spray on the pins before
you plug it into the instrument. We recommend the 3M Silicone Spray. Do not use the silicone
grease included in the toolkit on connectors, as this is intended for O-rings only.

Before deployment:

¢ Demate the connector set.

¢ Flush both halves of the connector set with compressed air and remove any dirt.

e Check that both connectors are dry. If not, let them air-dry.

e Inspect for damage, corrosion and cuts.

e Apply a thin film of 3M Silicone Spray or equivalent.

e Mate the connector halves, and mate any unused connectors with dummy plugs. Ensure the
rubber part of the female connector is properly seated over the pins before screwing on the locking
sleeve.

After deployment and before storage:

¢ Flush both halves of the connector set with compressed air and remove any dirt.
Check that both connectors are dry. If not, let them air-dry.

Inspect for damage, corrosion and cuts.

Mate with a dummy plug.

Cable Care

To keep your cables in good condition:

¢ Awid nicks and cuts around contacts, as these are the sealing surfaces.

¢ Do not pull on the cable to disconnect connectors; pull the connector itself.

¢ Awid sharp bends at cable entry to connector.

e Ensure that the cable is fixed to the mounting fixture to awoid mechanical stress to the
connection.

e Elastomers can be seriously degraded if exposed to direct sunlight or high ozone lewels for
extended periods.

Replace Desiccant Bag

Humid air can condense enough water do damage the electrical circuitry. At least once a year,
replace the desiccant located in the pressure case or the external battery canister. You may wish to
replace the desiccant bag more regularly if the instrument is exposed to multiple significant changes
in temperature (e.g. from a hot/humid surface environment to cool water). Refer to the battery
installation procedure for your instrument for instructions on opening the pressure case.

O-ring Care

O-rings are the critical component that keeps water out of the housing and thus the instrument dry.
Watertight sealing of the instrument housing is provided by double O-rings on the head and end cap
sub-assemblies. The outer O-ring forms the primary seal and the inner forms a secondary (or
backup) seal. If the integrity of the O-rings are degraded the instrument should not be re-deployed. In
this case, please contact us.
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6.6

If the instrument has never been opened, O-ring inspection is not necessary. However, when
changing batteries, the O-rings on the endbell are exposed. Make a routine of inspection,
maintenance and replacement of exposed O-rings.

e Check the O-rings and the O-ring grooves for grit, hair, lint, sand, or anything that could potentially
breach the O-ring seal.

o After frequent deployments or if O-rings or groves appear dirty, remove O-rings and clean the
grooves. To remove O-rings, use finger pressure or the rounded edge of a plastic card to lift the O-
ring out of the grove. Caution! Never use a metal object to remowve an O-ring. It may cause damage
to the O-ring or the sealing surface.

e To check O-rings for damage, place the O-ring between the middle and index finger and thumb.
Then pull the O-ring through your fingers, feeling for any debris or wear.

e If O-rings are dirty, it is best to replace them. Washing dirty O-rings with soap and water is not
recommended. Soap breaks down the lubricants and will compromise the integrity of the seal.

e Properly greased O-rings will help maintain sealing integrity and minimize O-ring degradation. Use
enough grease to lubricate the O-ring thoroughly, but not so much that it will attract additional
debris.

¢ Clean the groove with a lint free swab or the folded edge of a paper towel.

NOTE: Do not open the transducer end on your instrument to check O-rings. Opening the whole
instrument means exposing the electronics, and this shall not be done unless Nortek has approved
and provided guidance on how to do it.

Securing Screws

When installing end caps and sensor heads, care should be taken when tightening the screws. Just
a little tension on the screw is needed; when the O-ring starts to be compressed, turn each screw a
little at a time until the O-ring is fully compressed.

Tightening one screw fully before continuing on to the next may cause improper O-ring seating and
very high mechanical stress concentrated around the screw hole. This may cause leaks and/or
damage to the head or the endbell. The screws need only be tightened sufficiently for the O-ring and
spring washers to be fully compressed. Instead, use the cross tightening sequence: tighten one
screw slightly, then mowve to the screw opposite. Tighten that one slightly, then change to the next
pair of opposing screws and repeat. Continue in this pattern until the screws are sufficiently
tightened.

Ovwer-torquing has no positive effect and may damage the threads and/or area around the screw holes

on the head and end cap. Keep in mind that ocean pressure holds the end cap tightly; all the screws
have to do is to secure the end cap from falling out when the system is above water.

T

Figure: a) "Two-fingers" tightening of screws. Indicator arrow shows position before final tightening. b)
Final tightening 30-45 degrees from "two-fingers" tightening.
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6.7

Biofouling

Marine growth, or fouling, on moorings should be considered when planning long-term mooring
systems. Current profilers used in long term monitoring projects will be covered with biological
material. Eventually, the growth can become strong enough that the transducers are blocked and the
profiling range is reduced. To know when to maintain the instrument it is best to monitor the long
term variation in the amplitude data. This parameter varies with short time scales (depending on
suspended sediment concentration, zoo plankton, bubbles, etc.), but biological growth (especially
barnacles) adds a long term downward trend that can be monitored. The profiling range gradually
goes down as the growth on the sensor increases. At some point, the signal strength will be too low
to achieve the desired profiling range. Through experience you will gain knowledge about how long it
takes before the transducers are cowvered and this information can later be used to set regular
maintenance intervals where the transducers are cleaned.

When the instrument leaves the factory, the surfaces are quite smooth and it will take some time
before any growth starts. After the first cleaning, the surface is rougher and it becomes easier for new
material to grow. Typical maintenance intervals are 6-12 months, but the growth rates vary a lot with
the geographical location, water temperature, season, and deployment depth. In general, heawy
growth is seen in hot and shallow areas. Cold and deep water areas see very little growth so
maintenance can be less frequent.

When calculating forces, the marine growth is accounted for by increasing the expected weight and
diameters of the mooring line and all instrumentation attached, in addition to increasing the drag.

Antifouling paints and other agents are often used to awoid transducers being covered with barnacles
or other evil crustaceans during long deployments. The important thing when it comes to antifouling
is that the paint is not too thick, otherwise the signal strength may be affected. Nortek has tested the
effect of antifouling paints on the profiling range of the 2 MHz Aquadopp and no appreciable change
was found when a thin (1 mm or so) layer on the transducers was applied. You can probably use
most anti-fouling paints as long as it is not too (chemically) aggressive and contains no solids (metal
flakes, etc.) that could interfere with acoustic beams. Anodes and pressure ports should not be
painted.

Nortek has run a test with three different zinc oxides, a zinc paste with 40% zinc oxide, Silulen
(Nycomed) with 20% zinc oxide and Desitin (Pfizer) 40% zinc oxide. They all work quite well but the
Silulen a little less so. Our conclusion from the test was that a higher zinc oxide percentage is
probably better. Other options are use of thin plastic bag or Pettit's Trinidad anti-fouling paint (75.8%
cuprous oxide). A different approach is to use an anti-fouling adhesive patch that cowers each
transducer. These patches have doubled deployment lengths in warm, biologically-active waters by
keeping the transducers clear for longer and greatly increasing the required maintenance interval to
remove biofouling. They have no detrimental effect on the quality of the measurements from covered
transducers. Contact your local Nortek representative for more information.

We realize barnacles have to be removed mechanically, but we strongly advice against using sharp
objects capable of harming the polyurethane surface. We also recommend staying away from strong
organic solvents such as acetone. A common, easy, and inexpensive way to keep the Delrin housing
on the Aquadopp and Aquadopp Profiler clean is to wrap the housing in either clear packaging tape
and/or clear plastic wrap (such as the brand name "Saran Wrap"). At the end of the deployment,
simply unwrap the protective coating to find a clear instrument. Tapes such as "Duct Tape" can leave
a sticky residue that is very difficult to remowve (although it does not actually harm the Delrin housing).
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71

Troubleshooting

This section contains information in where to start looking if an instrument does not behawe as
intended. If you encounter a problem, you should:

¢ Get a good ovenview of the problem; make notes during the troubleshooting process

e Work in a systematic way and do not neglect the obvious. Start by looking at simple causes, such
as power not connected, bad connections, etc.

e If the setup uses custom cables, power supply, etc. first assemble and test the instrument using
the cable and battery (if applicable) that originally came with the instrument. You can always return
to the standard setup, which is the easiest way to get the system to work, to confirm that the
problems are not caused by a faulty instrument.

e If your instrument behaves strangely try updating both your software and firmware to the latest
versions. There may be incompatibility between an older version of firmware and newer version of
software, and vice versa. The latest versions of firmware and software can be downloaded from our

support page at http://www.nortekgroup.com/software
To help us give good support, please:

¢ Be specific about the error - a screenshot is often helpful

¢ Include a raw sample file or a collected data set showing the error (.ad2cp)

¢ Include information about firmware and software version used

¢ Include serial number (Head ID, Hardware ID or order number)

e A Support file can be downloaded from the instrument and is used to assist you in the best
possible manner. To retrieve this file, click Instruments > Get Support file. Alternatively, type in
the IP address in the web browser and click “Retrieve Support File”. A *.gz file is then downloaded
and can be sent directly to Nortek for diagnosis.

If it turns out that the instrument will have to be sent back to Nortek for repair, check out the FAQ on
RMAs for more information. Make sure to include all the information requested in the Proforma
Invoice document. You can provide your own, or use our example shown in Appendix.

NOTE: Do not open the transducer end on the Signatures when doing troubleshooting. Opening the
whole instrument means exposing the electronics, and this shall not be done unless Nortek has
approved and provided a guidance on how to do it.

Communication

Instrument connected through Ethernet cable

¢ Does the Ethernet cable have a source of power?

¢ If the instrument is \visible in the Discovery screen, try right-clicking and opening the Terminal
Emulator. Send Break then Switch to Command Mode, a confirmation message should appear.
Try connecting to the instrument as per normal.

e Consult the Universal Plug and Play section to find the IP address. Type this in the Discovery
screen of the Deployment software. If you are able to connect, but it does not appear in the menu
there may be an issue with the firewall. Try disabling your firewall and refresh the Discovery
screen.

e Check network cabling connection: If your computer has light emitting diodes (LEDs) next to the
connection where the Ethernet cable plugs into the computer, check if the LEDs are lit to indicate
the current status of the network device. If the LEDs are not glowing/blinking, check that the
connector is OK and try to re-plug. Refer to your computer's manual for information about the
Ethernet port LED.
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Check the LED on the switch or router. The LEDs should be lit when there is a connection
between the computer, the network router or switch and the instrument. If not, try switching it on
and off to reset the switch/router.

If an Ethernet switch is used, its Ethernet port should also show an active Ethernet link. Try
connecting with a different cable. If not, there is a problem with the computer connection.

If you have a button for turing on/off the wireless network antenna on your computer, turn this off.
Connect the communication cable directly from the computer to the Signature instrument to
bypass all of the network wiring and router. Is the PC showing that the link is active?

If the connection was lost all of a sudden; run a test and analysis function in Windows (see step-
by-step description below)

»

Figure 21. Ethernet por
computer.

Test and Analysis function in Windows

o=

Click "Start"

Click "Control Panel"

Click "Network and Sharing Center"

Click "Change Adapter Settings"

Right-click “Local Area Connection". This icon represents your Ethernet connection to the
instrument

Click "Diagnose." The analysis function in Windows will examine the failed connection and show
an explanation of the problem and some advices to fix the problem

Unlike the serial port, once you have verified that the link is active, there is no need to do anything
else with configuring the speed or other link characteristics. The next step is to make sure you have
got an appropriate IP address assigned. For details about the process of assigning IP addresses,
refer to the Appendix.

Instrument is connected through serial communication cable

Does the instrument have a source of power? Try using both internal and external battery/power
source.

Ethernet still connected and powered. The Signature will prioritize an Ethernet connection over a
Serial connection, so if both cables are plugged in and powered only Ethernet will be available.
Wrong serial port. Check that the correct serial port is selected. Go to Start - Control Panel -
Systems - Hardware - Device Manager - Ports (look for USB device)

Wrong baud rate. Try sending a break in the Terminal Emulator. If gibberish/non-sense or nothing,
check the baud rate settings.

Wrong serial protocol for the cable. Signatures can use both RS232 and RS422. Use the
command GETINST,RS to check which protocol is enabled.

There is a problem with the converter. Check that the LED on the conwerter is lit. If not, confirm that
the correct driver is installed.
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7.2

7.3

The blue LED indicator light on the instrument is not lit
e Is the instrument in Command mode?
e Does the LED blink (short) when applying power?

Cable
Cables are often exposed to heawy use and the power connector might break. Using a multimeter to
ping through each pin may reveal a breakage.

Power Supply
The power supply supplied with the Signature series comes with a plug that it is possible to attach it
incorrect. The Signature is protected by diode against reversal of polarity, but it will not power on.

e (0 O z (

Figure 22. Make sufe the plug on the power supply is
correctly fitted if it has been disconnected earlier

Network

Firewall
Firewalls are usually active by default and could be a possible cause for blocking communication.

For organizations with strong security / firewall restrictions, FTP access to the instrument may not
be permitted. HTTP (Hypertext transfer protocol) can then be used for data transmission. A web page
allowing individual data files to be downloaded has been implemented in the Ethernet processor. The
web page can be accessed by clicking on the “Data Download (HTTP)” link from the main web page.

Routers

There are some limitations to the discovery protocol. Multicast Ethernet packets are used to
implement the protocol and those packets may not be forwarded through routers (depending on the
router type and configuration). For that reason, the instrument should be either directly connected or
connected through a single Ethernet switch for troubleshooting. Once the IP address is properly
configured, it can be used to access the instrument using normal IP communications. Only the
discowvery protocol uses multicast packets. For more details about the Ethernet communication, refer

to the Appendix.

IP address
You have the possibility to enable/disable DHCP and set a static IP address, if necessary. Check
out this appendix for details.

Software Problem

Discovery tool; the instrument | want to connect to has red background. The instrument cannot be

connected to because of one of the following reasons:

e Non compatible firmware. Go to Help > Download Firmware to get the most up to date version.

¢ Instrument is on wrong subnet. This can be fixed automatically by double-clicking the instrument
name while in the Discovery screen.
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e The instrument listed is not supported by the software.
If the Discovery feature does not list your instrument, refer to the Communication Problem section.

Software crash

¢ Download the support file containing debug information: Help > Support files

e If your instrument behawes strangely (for example error messages when trying to start data
collection, compass calibration or pressure offset calibration), update both your software and
firmware to the latest versions. There can be incompatibility between an older version of firmware
and newer version of software, and vice versa. The latest versions of firmware and software can be
downloaded from our support page.
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Appendices

Glossary

Accuracy
AD2CP

AHRS

Altimeter
Amplitude
ASCII output
Bandwidth

Beam
Coordinates

Blanking

Break

Broadband

Cell

Coarse Profile

Command
mode

Compass
calibration

A value giving the degree of closeness of a velocity measurement to the actual
velocity. Refer to the data sheet for specific minimum accuracy.

Nortek's broadband signal processing platform.

Attitude and Heading Reference System. Provide attitude information and replace
the traditional tilt and magnetometer. AHRS is especially useful in dynamic
environments. Note that this feature also requires additional hardware.

Measures the distance to the surface
See signal strength
Data is displayed in ASCII format (text).

Wider signal bandwidth is used to get more information and improve the velocity
precision. Reduced bandwidth is used in long range mode (only relevant when
current profiling) to increase range. This bandwidth reduction makes the
measurements less precise.

In Beam coordinates, a positive velocity is directed in the same direction as the
beam points. Beam 1 is marked with an “X’ on the head.

Specifies the distance from instrument head to the start of the measurement cell
where no measurements take place, to give the transducers time to settle before
the echo returns to the receiver. The size of the blanking area is user selectable
in the software using the Start of profile parameter.

A break command is used to change between the various operational modes of
the instrument and to interrupt the instrument regardless of which mode it is in.
When break is received in command mode, you can see that the LED is
switched off for a short time.

In this context it means using a more complex transmit pulse to improve the
measurement accuracy in each ping.

One measurement cell represents the average of the return signal for a given
period. The cell size and transmit pulse are of equal size. The cell is shaped like
a triangle due to conwlution; this is indicative of the weighting of the
measurement.

Instrument setup that prioritize achieving the maximum range at the expense of
reduced resolution.

An instrument in command mode is powered up and ready to accept your
instructions. If no commands are received for about five minutes, it automatically
goes into Power Down Mode, unless Ethernet power is connected. LED is lit
constantly when in command mode.

Each compass system has been calibrated at the factory to quantify the
characteristic response of the individual components and of the system as a
whole. When it leaves the factory, each system can measure its tilt and the
direction of its magnetic field vector accurately. Howewer, users may disturb the
magnetic field near the instrument when they deploy. Adding a battery pack and
mounting the instrument with deployment hardware adds magnetic materials that
change the earth's field at the instrument. The compass calibration procedure
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Correlation
(nominal)

ENU
Coordinates

Fine Profile

Firmware

HR

Ice Draft (keel)
Ice Drift

Internal
sampling rate

LED

License

NMEA

Noise floor

Ping

Precision

Sampling rate

SDU
Coordinates

Sidelobe

quantifies this magnetic hard iron disturbance, and the instrument's compass
algorithm then corrects for it to obtain accurate heading.

Nominal correlation is a function of cell size and welocity range. Nortek
recommends using 50% of the max correlation as a cut-off value, beyond this
point the validity of your data is questionable.

Polar magnetic coordinates; East, North and Up. A positive east velocity goes
toward east. This is also a right-handed orthogonal system.

Instrument setup that prioritize the highest possible resolution at the expense of
the maximum range achievable.

Internal software of the instrument, as opposed to the instrument software
running on a PC. New firmware is posted on the Nortek site. You will need to
register to get access, but access is otherwise free of charge.

High Resolution. With the correct firmware and license, the instrument can
measure High Resolution data on the fifth, vertical beam.

Measures thickness of ice. Ice draft = Water depth - Distance to Ice

With the correct firmware and license, measures welocity and direction of ice
drift.

Rate of sampling for internal sensors. Refer to the specific instrument brochure
for details.

Light Emitting Diode, visible from the outside of the instrument. The LED can be
set to blink for every sample (On), blink for the first 24 hours of deployment (On
for 24h), or never (Off).

Different capabilities of the instrument are protected under licenses which can be
purchased. Contact your sales representative for more information. Register
purchased licenses while connected to your instrument under Instrument >
Licenses. Licenses that are ordered with the instrument are already registered.
You will not need a license when updating the firmware version.

Standard data format defined by the National Marine Electronics Association

The amplitude of the internal noise of the instrument. This will limit the minimum
detectable signal that can be received.

Same as a single transmit pulse.

The value given is a theoretical estimate of the precision of the welocity
measurements based on how the instrument is set up. The nominal value is
given for the horizontal components in a default instrument acoustic beam
configuration. In order to improve the precision the user may consider one of the
following options: (1) larger cell sizes, (2) longer awverage interval (3) reduced
velocity range, or (4) increased measurement load

Specifies the rate at which data is output

Speed - Direction - Up.

The acoustic beams focus most of the energy in the center of the beams, but a
small amount leaks out in other directions. Transducer sidelobes are rays of
acoustic energy that go in directions other than the main lobe. Because sound
reflects stronger from the water surface than it does from the water, the small
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signals that travel straight to the surface can produce sufficient echo to
contaminate the signal from the water.

Signal strength Strength of return signal, presented in dB.
Sleep mode The instrument is not actively collecting data
SNR SNR is the Signal-to-Noise ratio and is a data quality indicator.

XYZ Coordinates Cartesian coordinate system. A positive velocity in the X-direction goes in the
direction of the X-axis arrow. The X-axis points in the same direction as beam 1.
Use the right-hand-rule to remember the notation conventions for vectors. Use
the first (index) finger to point in the direction of positive X-axis and the second
(middle) finger to point in the direction of positive Y. The positive Z-axis will then
be in the direction that the thumb points.
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8.2

Communication and Ethernet

Connections between the instrument and computer can be made in one of two ways.

e Ethernet (via direct connection or router/switch)
e RS232/RS422 through the serial port. Serial communication baud rate: 300-115200, 230400,
460800, 625000, 1250000

Details about the Ethernet connection

Most instruments are shipped with the Ethernet option. The first time using the instrument, the
network address needs to be properly configured for the network. The IP address can be assigned in
one of the three ways:

1. Dynamic Host Configuration Protocol (DHCP): A DHCP senver in the network is used to assign an
IP address to the Ethernet interface.

2. AutolP: Link-local address assignment.

3. Manually assign IP address (by the user)

As shipped, the instrument uses options 1 and 2. This means that it will try to automatically
configure the IP address for the network that the instrument is plugged into.

If a DHCP server is detected it takes approximately 30 seconds to negotiate for and assign an IP
address to the Ethernet interface. If you are using a broadband router, it is likely you are using a
DHCP Sener to assign IP Addresses. Common private network address schemes include
192.168.x.x and 10.0.x.x subnets, with the Subnet mask of 255.255.255.0 or 255.255.0.0

If a DHCP senver is not detected (usually because of being directly connected to a computer) and the
request for an IP Address is not fulfilled, the Signature system will automatically assign itself IP
addresses using the AutolP protocol. DHCP must first time out before the AutolP protocol starts, so
this will result in a delay of approximately 90 seconds before an IP address is finally assigned. A
standard AutolP address sits in the 169.254.x.x range, with the subnet mask being 255.255.0.0.

When using automatic IP address assignment, there is generally no way of knowing which address
was assigned to the instrument. To determine the IP address assigned, the Discowery protocol is
used to query instruments on the local subnet. The discovery protocol is a Nortek proprietary means
for retrieving information from an AD2CP without requiring any knowledge of the IP address
assigned.

There are some limitations on the Discovery protocol. It uses a special type of Ethernet packets
(known as multicast packets) that may not be forwarded through routers (depending upon the router
type and configuration). For that reason, we always recommend that the computer being used for
Discovery ONLY be either directly connected to the instrument or connected through an Ethernet
switch. Only the Discovery protocol uses multicast packets. Other communications use standard
TCP/IP networking which means that the instrument can be communicated with anywhere that IP
connectivity is supported once the IP address is known.

For more details about the DHCP or AutolP there are many articles available in the public domain.
These are standard protocols used by most Internet based equipment.

Routers
The discovery protocol uses multicast packets that may not work through firewalls and routers. The
Time-to-Live for the multi-cast packets is set to 2. This means that at most one router can sit
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between the acquisition system and instruments. The router must also be configured to support
forwarding of multicast packets.

Manually assign IP address
Networked instruments can also have their IP address manually assigned. This may be useful on
networks in which the discovery protocol might not work (e.g. through multiple routers or firewalls).

Network Configuration

Right-click the highlighted instrument in the Discovery function dialog to get the option of enabling
DHCP or set a static IP address or IP address for a local interface (see screenshot of the dialog
below).

Network Configuration

Please wait...

Enable DHCP (Dynamic IP address)

Static IP address
IP address

Netmask

Gateway

Local interface
IP address

Cancel

Enable DHCP: Use a dynamically assigned IP address from a DHCP server or from AutolP instead of
a user supplied IP address. The IP address that gets assigned is also shown in this panel. AutolP
allows a local domain dynamic IP address to be assigned without the presence of a DHCP sener. An
instrument connected directly to the host will be assigned a special address in the 169.254.xxx.xXx
address range. In order for the Windows host to also select an appropriate address in this case, the
Automatic private IP address option in the Internet Protocol Version 4: Alternate Configuration menu
must be enabled.

IP address: The IPv4 address to manually assign to the network interface.

Netmask: The network mask used to identify the local subnet for the network.

Gateway: The router address used to connect to machines that are on a different subnet from the
instrument. The gateway must be on the same subnet as the IP address selected.

Local Interface: Shows which network interface on the computer is being used to communicate with
the instrument and whether or not full IP communications can be established.

Make sure the Network adapter is configured to obtain IP address automatically and is not set to
"fixed". This setting is found under Network and Sharing Center > Change Adapter Settings. Right-
click the relevant network and open "Properties”.

Telnet, Raw connection and FTP

The serial interface of the Doppler processor is accessible over telnet. A dedicated port can be used
for ASCII only communication whereas another port provides the complete set of data, including
binary data output of the measurements. This subject is covered in the System Integrator's Guide,
please refer to this guide for more information.

Nortek AS


http://www.nortekgroup.com/manuals-quick-guides

54

Signature Series Operations Manual

8.3

Terminal Emulator

The Terminal Emulator window allows you to communicate directly with the instrument using
commands. To open the Terminal Emulator connect to the instrument using the Deployment software
and click Communication > Terminal Window or while in the Discovery screen highlight your
instrument and press Ctrl + T. You can also right-click the specific instrument and select the
Terminal Emulator option.

Terminal

ek-bench Command Interface

[¢] NMEA (@) ASCIl () Hex | | Recorddata | | Incdlude commands | Upload file... | Switch to Command Mode

Figure 23. Terminal Emulator dialog

Command: Specify a command to send to the instrument, e.g. ‘ID’ to get the identification string.
Note the existence of a right-click menu, which is useful if you need to edit commands. Press the
Send button to send the command to the instrument. ASCIl commands may be typed directly in the
terminal window. Refer to the System Integrator's Manual for a list of commands and their syntax.
Up/down arrows can be used to access the command history, and the terminal window command
history are kept within sessions.

Send: Sends the command specified in the Command field.

Send Break: Sends a BREAK signal over the port. A break causes the instrument to report an
identification string when it is in command mode:

Signature1000 - NORTEK AS.

Version 2182_3 (Sep 17 2015 18:31:28)
COMMAND MODE

OK

Protocol: Select NMEA format if applicable

Decoding

e ASCII: Display instrument output in ASCII format.

e Hex: Display instrument output in hexadecimal format.

Record data: Lets you capture the data to file.

Upload file...: Specify the name of a file containing an ASCIl command to send to the instrument.
Switch to Command Mode: Put the instrument in command mode.
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8.4

Web interface

The AD2CP network processor runs a web server for displaying basic information about the
instrument. To access the Web site, first make sure you are connected to an instrument. Find the
instrument in the Windows Explorer > Networks and double-click. Check out "Properties" for more
details about the system. Alternatively, you can use the IP address of your instrument and type this
directly in the address line in your web browser.

From the web site you have access to:

Network configuration

The Network Configuration page provides another mechanism other than Discovery for changing the
saved instrument name and IP addressing information. Changing the IP address will result in the URL
in the web browser having to be updated with the new IP address.

Maintenance
This area present system information and let you set the clock. Also upgrades and updates, erasing
and reformatting the SD card is possible from here. The Retrieve Support File button is used to
collect internal logs and run-time information for both processors into a single file (*.gz) that can be
sent to Nortek for analysis. The instrument must be in command mode for a complete support file to
be generated.

Logs

These files are useful if you need support. The Instrument log contains production information, the
Deployment log contains instrument usage history. The Add Deployment Log Entry enables the user
to add entries to the deployment log. The Network and System logs are mainly for debugging
purposes.

Security

Password protection may be used to restrict access to the instrument. In order to enable or disable
password protection, the password for the “nortek” account must be entered first (this to make sure
that the password is known prior to enabling protection and to prevent protection from being disabled
by an unauthorized person when enabled). Two passwords are available: one for the real-time
interfaces (the ASCII, raw and data interfaces; see the Integrator's Guide) and one for FTP access to
the instrument recorder. The default password for both accounts is the same as the username
(“nortek” for the nortek account and “nortekftp” for the nortekftp account).

Data Download (HTTP or FTP)
Download data from the instrument. Note that this will interrupt running measurements.
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8.5

Universal Plug and Play

In addition to the proprietary discowvery protocol, the UPnP (universal plug and play) protocol is
supported by the AD2CP platform. This allows the operating system which are UPnP capable to
discover the instrument with no need for proprietary software. To view the instrument icon in Microsoft
Windows, open the Network view of the computer.

RS
QUv W& » Network » v |4y el
| |
Organize ~ Netwaork and Sharing Center Add a printer Add awireless device L= -+ (7]
Favorites 4 Cgmpmm 1)
o Libraries A * NORTEK-HR23
£
& Computer 4 Media Devices (1)
i E;
4 Qi Network NORTEK-HR23: rcraig:

A NORTEK-HR23
4 Network Infrastructure (1)

=% RT-AC68U
4 Other Devices (1)

‘M signature 1000_AD2CP
—

@ 4 items

Figure 24. Network view

Double clicking on the instrument icon brings up the web page interface. Right clicking and selecting
Properties gives the IP address and other instrument configuration information.

- Signature 1000_AD2CP Properties &

 Network Device
Signature 1000_AD2CP

Device Details

Manufacturer: Nortek AS

Model: AD2CP

hitp:{/www. nortek-as.com
Model number: 1000kHz
Device webpage: hitp://192.168.20.

Troubleshooting Information

Serial number: 112233

MAC address: 8c:68:78:00:00:f

Unique identifier: uuid:Upnp-AD2CP-1_0-112233
IP address: 192.168.20.10

ok | [ cance |

Figure 25. Properties

In order for UPnP to operate on Microsoft Windows platform, Network Discovery needs to be enabled.
This is normally enabled by default on "Home" and "Work" networks but disabled on "Public"
networks. To see if Network Discovery is enabled, open the Network and Sharing Center (Control
Panel: Network and Internet: Network and Sharing center) and click on the Change advanced sharing
settings selection. This will bring up the various network types (Home/Work/Public). Select the
network type that the instrument is connected to and ensure that Tumn on network discovery is
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8.6

selected for that network. If the network is a public network, it is recommended that network
discovery be turned off after interaction with the instrument has been completed.

Synchronization

The Signature series has advanced synchronization features built in, either using Ethernet PTP,
hardware trigger signals, serially through a command or trigger on a differential RS485 compatible
hardware signal. The instrument can also be configured to be a synchronization master, outputting
an RS485 sync pulse. This allows several Signature instruments to synchronize their sampling with a
small increase in power consumption. The various synchronized units must be identical (for example
only Signature500s) and use the same ping scheme. For more details about the different
synchronization options, check out the Integrators Guide - AD2CP.
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8.7 Connector Pin Configurations

Other Connector Pin configurations are available upon request.

6-pin connector, Standalone, Ethernet (N2550-003, N2550-008)

Connector on|Pin Function [Wire Join | Wire color Pin Connector on the
the numbe color t numbe | computer side
instrument r r
side
MCILEM with |1 Gnd Black Black Jacket | 2-pin jack plug
MCDLS-F 2 Pwr+ Red White Center
(red)

3 Rx- White Green 6 RJ 45 insulation
Male  face|4 Rx+ Blue Green/White |3 connector
view: -

i . 5 Tx- White Orange 2
6 Tx+ Orange Orange/Whit |1
e

2-pin connector (N2100-608)

Connector on|Pin Function | Wire color Pin Connector on the external
the numbe number canister
instrument r
side
MCIL2M-G2 (1 Pwr + Twisted pair, 1 IL2M with DLSA-M(red)
with  MCDLS- Red/Green
F(red) 2 Gnd Twisted pair, | 2
Black/White

8-pin connector, Serial communication w/RS485 sync (N2550-021)
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Connector on|Pin Function [Wire Join | Wire color Pin Connector on the
the numbe color t numbe [ computer side
instrument r r
side
MCIL8M with |1 Gnd Black Black Jacket | 2-pin jack plug
MCDLS-F 1, Pwr+  |Red White Center
(red)
3 RS232 Tx [ White Red 2 9-pin DSUB
| RS422
Tx- 5 1
4 RS422 Blue White 8
T
Tx+
5 RS232 White Orange 3
Rx /
RS422
Rx+
6 RS422 Orange Purple 7
Rx-
7 Sync A [White Blue 1 2-pin terminal block
8 Sync B [ Green Black 2

7-pin Souriau connector (10M), Online, Ethernet (N2550-016) - Signature500, Signature1000

and Signature250

Connector on|Pin Function [Wire Join | Wire color Pin Connector on the
the numbe color t numbe | computer side
instrument r r
side
7-pin Souriau|1 Gnd Black Black Jacket | 2-pin jack plug
(FED 10M) 2 Pwr+ Red White Center

3 Rx- Green Green 6 RJ 45 insulation

4 Rx+ White Green/White |3 connector

5 Tx- Blue Orange 2

6 Tx+ Orange Orange/Whit |1

e
7 Shield Uninsulated |8

7-pin Souriau connector (14M), Ethernet (N2550-014, N2550-015) - Signature55
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Connector on|Pin Function |Wire Join | Wire color Pin Connector on the
the numbe color t numbe [ computer side
instrument r r
side
7-pin  Souriau| 1 Gnd Black Black Jacket | 2-pin jack plug
(FED14M) 15 Pwr+  |Red White Center
Male face|3 Rx- Green Green 6 RJ 45 insulation
view: 4 Rx+ White Green/White |3 connector

5 Tx- Blue Orange 2

6 Tx+ Orange Orange/Whit |1

e
7 Shield Uninsulated |8
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Proforma Invoice

NQRTEK

NOT A SALE

Temporary export to Norway for repair

Sender (Exporter) Receiver

Name: Name: Nortek AS

Address: Address: Vangkroken 2

City: City: N-1351 Rud

Country: Country: Norway

Tel: Tel: +47 67 17 45 00

E-mail: E-mail: support@nortekgroup.com

Ref: Customs Account No.: 322 68 794
VAT/Company No.:996 707 415 MVA

About the goods

Date: Description of Goods:
Delivery Terms: No. of Units:

Delivery method: Weight:

Tracking no: Origin:NO

Reason for Export: Total Value:

Return for repair Nortek RMA No.:
Temporary

Place:

Date:

Exporter’s Name:
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